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Using On-line Help: Inside back cover

To view a step-by-step tutorial that will help you get started with CoPilot, select Run Tutorials from the Help menu.  For a demo of CoPilot’s features, see the movie included on the Installation CD.  Please read the License Agreement and Warranty information before your first use of the software.

CoPilot 2000 Quick Start

1. Plug the PS/2 port connector of your GPS unit into the PS/2 port of your computer.  Boot up your computer.  Do not, however, plug the serial port connector of your GPS receiver into your laptop until after Windows 95, 98 or Windows NT has finished booting up.

2. Install CoPilot by placing the Installation CD (disk 1 of 2) into your CD-ROM drive.  (If Autorun does not automatically load, see page 4).  IMPORTANT: Remember to Install Speech if you want CoPilot to speak to you.

3. Place the Data CD (disk 2 of 2) into the CD-ROM drive.

4. Make sure the date and time are set correctly on your computer.  This is extremely important for CoPilot to function properly.  To check and/or change the date and time, go to the Windows Start button, Settings, Control Panel, Date and Time. 

5. Double-click on the CoPilot icon on your desktop.  CoPilot will greet you and ask you to enter your destination.  You should enter your destination in the Trip Planner window (City, State or Zip Code, and optionally, Address).  NOTE: You do not need to enter a start place.   

6. After just a few seconds, CoPilot will generate a route for you -- highlighted in green -- on the map.  This is CoPilot’s recommended route to your destination.

7. Start driving and listen for CoPilot’s instructions. 

Additional Tips:

· From the GPS control panel (on the right side of the map window, with a black background), you can turn various features on or off.  Tracking and Navigating must be On in order for CoPilot to give you directions.  NOTE: If Passenger is On, your map will always be shown.  If Passenger is Off, your map will not be shown when you drive at more than 5 m.p.h.  You will still receive verbal instructions as well as simple printed directions on screen.  In driver-operated mode, pull over to the side of the road to look at the map and/or the GPS control panel.  Even if a passenger operates the computer, for safety reasons the driver should never look at the computer screen while driving.

· Speaking and Listening can also be turned on or off depending on your preference.  NOTE: CoPilot’s voice recognition mode requires a high-quality microphone and is sensitive to surrounding noise.  Under ideal conditions, CoPilot will respond to your voice commands as you drive.  Speak loudly and clearly and wait a few seconds for a response.  

· When using CoPilot in the car, try making your mouse pointer larger to improve its visibility.  To do this, go to Start/Settings/Control Panel and double-click on Mouse.  Under the Pointers tab, choose “Large” from the Scheme drop-down box and click OK.

Getting Started...

What Do I Need To Run CoPilot 2000?

· Microsoft® Windows® 95/98 or Windows NT (4.0 or higher)

· IBM compatible PC (portable required for in-car navigation)

· Pentium processor or better

· 4X CD-ROM or better

· 16 MB of RAM and a hard drive with at least 125 MB of available disk space.  For best performance of “talking maps” and GPS track files, we recommend 24 MB of 
RAM and 325 MB of available disk space is recommended.

· A serial port

· A Soundblaster compatible sound card and speaker for “talking maps”.  For best results, a CD cassette adapter which broadcasts sound into your car stereo speakers is recommended.

· CoPilot’s voice recognition requires a microphone and a low-noise environment.  For best results, an external microphone is recommended (plug in before starting CoPilot).

Installation and Startup

Your CoPilot 2000 package includes CoPilot’s GPS hardware receiver (with serial cable and PS/2 power connector), two CD-ROM’s (an Installation CD plus a Data CD), and this User’s Guide.

To install CoPilot, first turn on your computer (and the external CD-ROM drive if necessary) and insert the Installation CD.  Have the installation key code from the front of the CoPilot CD holder ready.  NOTE: Do not lose this number.  You will need it for installation and registration.  See the on-line Help topic Registering Your Software. 

Windows 95: If Autorun does not automatically load, click on the Start box and choose Run from the menu.  Type your CD-ROM drive letter, a colon, and “\select” (example: d:\select).

Windows NT 4.0: Choose Run from the File menu, then type your CD-ROM drive letter, a colon, and “\select” (example: d:\select).  Choose “Install CoPilot” in the panel that appears and follow the installation instructions.  Now install the software that enables CoPilot to speak out loud to you by choosing “Install Speech” from the installation panel, and follow the instructions (YOU MUST DO THIS IF YOU WANT CoPilot TO SPEAK TO YOU).  After installation is complete, you’ll need to insert the Data CD each time you run CoPilot (unless you chose to install the data on your hard drive). 

To start CoPilot, double-click on the CoPilot 2000 icon that was created when you installed the program.  To quit at any time, select Exit from the File menu.

How Reliable Is CoPilot 2000?

At TravRoute, we would love to say it’s perfect, but of course we can’t.  And we understand that you’ll be disappointed when you encounter occasional data errors as you use the software.  The program won’t give you 100% accurate information every time you use it, but it will be a valuable tool.  Used in conjunction with your common sense, it can be tremendously helpful, saving you time and worry (besides being fun to use!).

Data Quality

CoPilot may give you inaccurate information at times because the local level street system in the United States is incredibly complex and constantly changes.  We have tried to incorporate updated and complete road information, but our map database is not perfect.  CoPilot must be used in conjunction with your ability to follow local traffic regulations and rules spelled out on local signage.

Although we have street-level coverage of the 48 lower states, your exact street may not be included.  Odds are, though, that you’ll find a street near the one you’re looking for.  TravRoute continually updates its database and we apologize for any omissions.  As we strive for a more complete product, we ask for your help.  If you encounter missing or inaccurate data, please e-mail, fax, or mail it to us so we can include it in our updates.

In addition, we have one-way street coverage in more than 100 metropolitan areas.  Our one-way street data is incomplete, and may contain errors and omissions, so please be alert when driving and follow local street signs.  CoPilot does allow you to modify one-way street restrictions yourself (see page 35).

CoPilot has complete coverage of full highway interchanges.  We’ve attempted to correctly identify connections between roads, but there may be errors.  Pay special attention to ramp signage.  And please let us know about any discrepancies in the CoPilot data.  There may be some places where we show a connection between two roads which does not exist and other places where we fail to show an existing connection.  With your help, future CoPilot releases will contain corrected information of this type.

In general, our map database is remarkably accurate, but not perfectly so.  You can judge for yourself by examining CoPilot’s mapping of a town or a route that you’re familiar with.  Please enjoy our product and realize that TravRoute is committed to improving both the software and the data.

GPS Accuracy

As explained in the section How Accurate Is GPS Tracking?, the GPS signal CoPilot receives from the constellation of satellites has a rated accuracy of 100 meters.  This means that 95% of the time the reported location is within 100 meters (300 feet) of your exact position. CoPilot takes this location information and enhances it further by “snapping” it to our street and highway network.  As a result of these two factors, CoPilot will sometimes place you on the wrong road (you can check to see whether this has occurred by asking “Where am I?” and comparing CoPilot’s statement of what road you’re on to the posted signs).  If this occurs, keep driving and CoPilot will automatically correct itself and find your proper position.

At times, CoPilot’s GPS tracking will be less accurate or fail to work at all because the unit is unable to receive satellite signals.  However, the unit is resilient; eventually, it finds itself.  Its ability to report your location is directly proportional to its ability to receive accurate line-of-sight satellite signals.  Heavy foliage, buildings, or any other structures obstructing satellite communications will interfere with CoPilot’s ability to track your location.  Like your car radio, GPS tracking can also be affected by weather conditions if severe.  Again, be patient.  CoPilot will continue tracking as soon as adequate signals are available.  NOTE: The GPS unit should be placed far forward on the dashboard to maximize the satellite reception area.

A Safety Warning

Do not use CoPilot in any way that interferes with safe and attentive driving!  For safety, we strongly suggest that you bring a passenger with you to operate CoPilot, particularly when using the Passenger mode.  If you are the driver and also operating CoPilot, Passenger mode should be Off in the map window’s GPS panel; this will cause a black screen to be displayed at more than 5 m.p.h., but the voice technology will remain active and you’ll receive simple turn instructions on the screen.  CoPilot will alert you to upcoming turns, respond with a status update if you press any key, and under ideal conditions CoPilot will respond to your voice commands.  Map graphics will only be displayed when your speed drops below 5 m.p.h. or when GPS signals are not received for about 30 seconds. 

When using CoPilot in a vehicle, do not place the GPS receiver, antenna, power supply, or your computer where it may strike the driver or passengers if the vehicle turns sharply or stops abruptly.  This product is designed, manufactured, and intended as an aid to planning, tracking, and following routes in privately-owned vehicles.  The accuracy of the map data, driving directions, and GPS tracking system is insufficient for this product to be used for automated navigation or in any situation in which the failure of the product could lead directly to death, personal injury, or physical or environmental damage.  The driver must always stay alert to actual road conditions and obey all posted signs and traffic regulations.  TravRoute Software and its suppliers specifically disclaim any express or implied warranty of fitness of this product for automated navigation or for aiding in the operation of other than a privately owned vehicle.

CoPilot 2000’s Navigation Mode

For real-time directions as you drive

GPS Overview

The Global Positioning System (GPS) is a tracking and navigation system developed by the U.S. Department of Defense.  The system uses 24 satellites that orbit the earth, sending out radio waves that can be picked up by GPS sensors (hardware devices for receiving data).  Normally, a GPS sensor relies on receiving signals from four satellites simultaneously to track its position.  Each signal contains an identifier for the satellite that emitted it and the exact time it was emitted (to the nanosecond).  GPS relies on the fact that radio waves travel at the speed of light to calculate distances, and the exact location of the sensor is figured by combining the data received from three or four satellites.

Given the right conditions, a GPS sensor can identify your geographic position anywhere in the world (although, at present, CoPilot can only display your location on a map of the continental United States).  GPS is able to give you the latitude, longitude and elevation of your present location, and also your road speed and direction of travel on a route.  Now you too can track your position and generate dynamic directions using CoPilot!

How Accurate Is GPS Tracking?

The accuracy of the information you receive from CoPilot will depend on several factors.  Atmospheric conditions can affect the ability of the GPS sensor to pick up signals.  So can the physical position of the device and its surroundings.  Tall buildings, foliage or other natural or man-made obstructions can affect the precision of your data.

In addition to these physical limitations, the U.S. Department of Defense has intentionally placed a limit on the availability of precise positioning data to civilians.  GPS satellites emit two types of radio signals: Standard Positioning Service (SPS) for civilians and Precise Positioning Service (PPS) for military and other authorized personnel (CoPilot, like all other GPS hardware devices on the consumer market, receives SPS signals).  The Department of Defense purposely inhibits the accurate transmission of SPS signals through a process called Selective Availability (SA).  When SA is affecting your data, your position can be detected within 328 feet (100 meters) horizontally and 512 feet (156 meters) vertically about 95 percent of the time.  When SA is active, CoPilot tries to increase accuracy by correcting the tracked position to the nearest road.  Although this has occurred infrequently, the Department of Defense may also choose to make GPS information unavailable to SPS users for short periods of time. Despite these limitations, you can expect CoPilot to provide you with useable and accurate information most of the time. CoPilot will alert you if accurate information is unavailable.

Setting Up the Hardware

To set up your GPS hardware using the power from your portable computer’s battery, plug the PS/2 port connector of your GPS unit into the PS/2 port of your computer (see the illustration below).  Boot up your computer.  Do not, however, plug the serial port connector of your GPS receiver into your laptop until after Windows 95/98/NT has finished booting up.  The GPS receiver works like a radio antenna, so place it at least two feet away from possible sources of interference (for instance, a cellular phone antenna).  If you would rather power the GPS receiver from your car’s cigarette lighter, see the illustration on page 7.

[PICTURE HERE]

The first time you use your GPS receiver, it will need to initialize using a “cold start”.  This typically takes about 3-5 minutes.  After you use it once, the GPS system should initialize in about 60 seconds.  However, if you don’t use the unit for about two weeks, it may need to go through the cold start initialization again.  

After powering up your GPS receiver, select Status... from the GPS menu to open the GPS Configuration dialog box.  Make sure the correct port is displayed under Serial Port -- the GPS receiver should be connected to this port.  TIP:  To see the serial ports available on your PC, open the Control Panel, select System, click on the Device Manager tab, then click on the plus sign next to Ports in the list of devices.  The Settings box displays the hardware settings used by the COM port.  The setting for your COM port should be 4800,8,N,1.

[PICTURE HERE]

Additional Hardware Setup Tips:

When running your laptop in your car, you need to power it up without the benefit of a powered outlet.  You can either rely on the battery in your laptop or you can use the power from the car’s battery.  To use the car battery, you’ll need to convert from your laptop’s plug to a 12 volt car battery cigarette lighter style plug using what’s called a “power converter”.  You can purchase one of these units from your local electronics store.

Most laptops come equipped with a sound card and built-in speakers.  You can adjust the volume output from your laptop by using the Volume Control panel that comes with your system.  Frequently, however, the small speakers on a laptop won’t produce sufficient volume to be heard in a moving automobile.  To amplify the output, you can plug something into the speaker jack, such as additional speakers.  Another alternative is to purchase an audio cassette adapter equipped with a cord and jack that you can plug into your laptop’s speaker jack, then put the cassette into your car’s stereo cassette player.  This will channel CoPilot’s commands through your car’s stereo system if it’s set to play audio tapes.

How CoPilot 2000 Uses GPS

CoPilot uses the GPS positional data that it receives from the hardware unit to display your current position and route on a map as you drive.  This is called “tracking”.  CoPilot also uses the GPS data it receives to “navigate”, that is, to guide you along your planned route, provided you entered at least a destination in the Trip Planner window.  Tracking will begin automatically when you start navigating by entering a destination.  Tracking may also be turned on without navigating.  In this case, you’ll see your trip tracked on the map as you drive, but you won’t see a highlighted route on the map and you won’t be given directions.

The GPS control panel in the map window displays various options (double-click an option such as Passenger to toggle between Off and On).  The scrollable list contains menu options and voice commands that can be double-clicked or spoken.

[PICTURE HERE]

Start Navigating!

If your GPS receiver is installed properly and CoPilot’s GPS software options are set the way you want them, you’re ready to start navigating!  CoPilot’s navigation system will guide you along the route you enter in the Trip Planner window, and recalculate your route should you miss a turn.

Because CoPilot needs to know where you’re going in order to give you navigation advice, you must enter a destination in the Trip Planner window to operate in Navigation mode.  If you enter a destination, Navigation mode will turn on, the map window will open, and a  highlighted route will appear on the map that starts at your current position, passes through any intermediate stops or “vias” you entered, and ends at your destination. Your route will also be tracked on the map while you drive.  (NOTE: If Passenger is Off in the GPS panel, your screen will turn black at more than 5 m.p.h., but CoPilot’s voice technology will remain active and you’ll receive simple turn instructions on the screen.) 

For intermediate stops, CoPilot will guide you to the precise location you entered; for unreported stops (“vias”), the generated route will only pass near that location while CoPilot guides you to the next stop or your final destination.  If you deviate far enough from your pre-planned route (you might make a wrong turn or choose to follow your own variation of the route), CoPilot’s “dynamic directions” will automatically recalculate the path to your destination from your current position. 

Navigating With a Pre-calculated Route and Dynamic Directions

1. Enter an end city or place, with or without a street address, in the Trip Planner window (refer to CoPilot’s Trip Planning Mode, page 20).  Do not click the Run button to calculate the route.  You may enter intermediate stops before entering a destination if you like -- CoPilot will route you to each one in the order in which you entered them. 

Entering a destination will activate the map window.  The GPS control panel should be visible to the right of the map.  You’ll see your highlighted route drawn on the map from your current position to the destination you entered.  Once you start moving, your position can be accurately tracked,   When Tracking is highlighted green in the GPS panel, you’re receiving a good signal; when it’s yellow, signals are being received from two or three satellites (rather than four); and red means that sufficient information for accurate tracking is unavailable.


2. Start driving!  As your GPS unit receives signals, arrows will appear on the map beginning at your start place and following your route as you drive.  CoPilot will automatically prompt you and tell you when your next turn is coming up.  If you go off route, CoPilot’s “dynamic directions” will reroute you to the next stop from your current position.

Tracking Without a Set Destination

1. If your GPS receiver is connected when you start CoPilot, tracking will automatically begin. Minimize the Trip Planner and maximize the map window.  If you connected the unit after starting the program, select Start Tracking from the GPS menu.

2. Start driving!  As your GPS unit receives signals, you’ll see arrows appear on the map that follow the route you take. To place your current position in the center of the map, either speak the command “Where am I” or highlight it on the scrollable list (use the up and down arrows on your keyboard) and press <Enter>.


Using the GPS Control Panel

The GPS control panel appears on the right side of the map window unless this option is turned off in the Preferences dialog box (see page 11).  To use the panel, first maximize the map window if it is minimized.

Tracking will turn on when you first start CoPilot.  If no GPS data is found in 10 seconds, it will turn off and CoPilot will silently wait until tracking is turned on again or until you enter a destination in the Trip Planner window.  To turn tracking mode On, highlight Tracking and double-click with the mouse or press <Enter> or the space bar (use the up and down arrow keys on your keyboard to scroll the panel).  To enter a destination (or a complete trip if you like), highlight Destination and press <Enter>.  If you enter a destination when tracking is on, Navigation mode will be activated; your route will be calculated (you’ll see it highlighted on the map) and CoPilot will guide you to your destination, even if you miss a turn or two.

While driving in Navigation mode, CoPilot’s “talking maps” prompt you before each turn.  You can also speak a command and CoPilot will respond.  For instance, you could ask CoPilot “How far?” to your destination or next stop (see page 15-16 for details).  The scrollable list in the bottom portion of the GPS panel includes all the voice commands that CoPilot recognizes, plus some menu options that won’t respond to your voice (On or Off appear next to these).  To activate any command or option on the list without using your voice, just highlight it and press <Enter> or the space bar.  NOTE:  Speaking and Listening must be turned on (scroll down the list to see these options) for CoPilot to recognize your voice commands and respond out loud to them.

Speech recognition and feedback indicators at the top of the map window (an ear and a speaker respectively) display the current status of CoPilot’s advanced voice activated system.  The significance of the various colors displayed is explained in the on-line Help topic Speech Recognition and Feedback Indicators.

Advanced GPS Software Settings

CoPilot provides you with several optional settings that enable you to control the way your GPS navigation system operates.  To access CoPilot’s GPS software settings, select Preferences... from the Edit menu to bring up the Preferences dialog box with the Options tab open as shown below.  This tab contains check boxes that turn general program options off and on (see the on-line Help topic Changing Your Program Settings for more information).

[PICTURE HERE]

Show text and commands in map window shows or hides the GPS control panel (see page 10).  Auto log when tracking turns automatic logging on or off  (see page 15). 

To activate CoPilot’s GPS voice response system, click on the Speech tab and turn on Listen for voice commands.  This tells CoPilot to listen as you speak when you’re navigating with GPS.  Click on the Commands button to see a scroll list of voice commands that CoPilot recognizes.  The Device selected from the pick list should match your computer’s sound board.  

Click on Speak feedback out loud if you want to hear CoPilot respond to your voice commands and to automatically prompt you about upcoming turns as you drive.

IMPORTANT:  If CoPilot isn’t speaking, make sure the necessary software is installed.  From the Windows Start menu, go to Settings/Control Panel, then Add/Remove Programs, and check for Watson on the list in the Install/Uninstall tab.  If it isn’t there, insert the CoPilot Installation CD and choose the Install Speech option to install the Watson software.

To test the voice response system, click on the Test button.  If you don’t get an audible response when you do this, try turning off Speak feedback out loud (click on it again), then turn it back on and test it once more.

TIPS: Speak slowly and clearly towards the microphone.  Be sure to verify that your computer has a microphone!  If you still aren’t getting a response, check to see if the volume control on your computer is set properly, and make sure your computer has a sound card and speakers.  You can also try reloading the system.  If CoPilot doesn’t seem to be recognizing your voice commands, you may want to try using an external microphone.  Be sure to attach the microphone to your computer before starting CoPilot.

If you have an Internet connection and Web browser software installed on your computer, you can access the Internet from within CoPilot.  TravRoute's Web site gives you access to extensive travel information for most major cities and towns in the continental United States.  You'll even be able to make reservations on-line.  If you have an Internet connection, use the Internet tab of the Preferences dialog box to indicate how CoPilot should search for your browser (see Accessing the Internet With the Geo*Browser, page 35).

WARNING: CoPilot’s navigation instructions are only computer-generated advisories and may contain errors.  Obey all local traffic regulations even if they are completely contradictory to CoPilot’s navigation suggestions.  Keep your eyes on the road and hands on the steering wheel!  Do not attempt to look at CoPilot’s screen if you are the car’s driver!  TravRoute assumes no responsibility for any damage or injury resulting from the use of CoPilot.

If you have Netscape Navigator, Microsoft Internet Explorer, or Quarterdeck Mosaic installed, select one of them.  If you have another type of browser software installed, click on Other and then type the correct path in the Browser's Full Path box.  If you need to search for the location of your browser software, click on Browse…  to search your files.  To test your Internet connection, click on the Test button (this should bring up the Internet at TravRoute’s home page www.travroute.com).  Besides the browsers listed above, CoPilot can use any installed SDI-compliant browser.  The SDI (Software Development Interface) standard used by CoPilot allows remote control of your browser using DDE.  NOTE:  Before attempting to start a browser, CoPilot will attempt to connect to one that is already running.  SPECIAL NOTE TO NETSCAPE USERS:  You may have to switch to Netscape to bring the Netscape window out from behind CoPilot once a connection is made.

For additional settings, select Navigation Feedback... from the GPS menu.

[PICTURE HERE]

In the Navigation Feedback tab of the GPS Configuration dialog box, the slider bar indicates when CoPilot will give you a last warning before the next turn on your route.  The default is set at 15 seconds.  When Scroll map automatically is checked, the map window automatically scrolls so that your current vehicle position is framed.  This setting should generally be turned on. 

Use the radio buttons under Size of Arrow to determine the size of the arrow cursor on your screen.  Choose S (small), M (medium), or L (large).  When you are navigating, this panel also displays what your next turn will be, your current location and destination, and how far your destination is from your current location.  NOTE:  When your receiver is picking up signals, you’ll begin to see “TimeStamp, Position” in the GPS cell at the bottom of the GPS Configuration dialog box.  The Logging and Tracking panels turn green when CoPilot is logging and/or tracking.

[PICTURE HERE]

When you’re tracking a route or viewing a log file, the Status tab displays the following data:

Message
The type of GPS signal CoPilot is receiving

Latitude
The latitude of your current position

Longitude
The longitude of your current position

Heading
The direction you are heading, in degrees, with North at 0 and 360 degrees

MPH
Your current speed

Elevation
Your current elevation

Satellites
The satellites from which CoPilot is receiving signals

UTC Date
The current Universal Time Coordinated date (not necessarily your current date).  UTC is a world-wide clock time like Greenwich Mean Time.  NOTE: For time accuracy, have your computer’s date and time set accurately.

UTC Time
The current UTC time (not necessarily your current time).  UTC time accuracy is important because it helps your GPS receiver “know” which satellites to look for to get the signals it needs.  Inaccurate time may cause the receiver to search for the wrong satellites first, thus slowing down its acquisition of correct positional data.

Quality 
The quality of the signal you are receiving.  No Fix means that more satellites are needed for accuracy; 2D Fix means that enough satellites have been contacted to produce a reliable signal; and 3D Fix means that the optimal number of satellites has been contacted.

PDOP
This is a measure of the positional accuracy of your GPS signal.  The closer to 1 the PDOP is, the better. Possible range is 0-99.

Creating and Playing a Log File
CoPilot enables you to record and save a log file of all or part of your route as you track it.  This file can be stored and played back on your computer for future reference. CoPilot will automatically begin logging when you begin tracking your route.  If you do not want to log, go to Preferences... from the Edit menu, and remove the check in the checkbox next to Auto log when tracking if it is checked.  

CoPilot saves GPS track files to the default directory where you installed the program, using the current date to create a file name.  To assign a different name to a log file, use the Windows Explorer to rename the saved file.  Logging can be turned off during a trip using the GPS control panel.  If saved log files are taking up too much space on your hard drive, use CoPilot’s Zip feature (see Using CoPilot’s Zip GPS Function to Compress Files in on-line Help).

To play back a saved log file, choose Playback Log File... from the GPS menu to activate the GPS Playback tool bar.  Next, click on Open and select a log file from the Windows dialog box that opens.  Now click Play and watch as your route replays in the map window (you must enter your destination in the Trip Planner window to see the route that you took highlighted on the map).  To stop the replay at any time, click Stop on the tool bar.  To eliminate tracking signals up to the current tracking position, click on Clear.  If you want to slow down or speed up the playback, click on the small arrows on the GPS Playback tool bar.

Using Voice Control

To use CoPilot’s GPS voice response system, first make sure both speech options are turned on in the Preferences dialog box (see page 11-12) or in the GPS panel scroll list.  With both options on, you’ll be able to issue verbal commands and hear CoPilot talk back!  For instance, CoPilot can tell you what street you’re on, what your next turn is, and the distance to your destination. 

IMPORTANT:  To have CoPilot speak to you, you should also make sure the necessary software is installed.  From the Windows Start menu, go to Settings/Control Panel, then Add/Remove Programs, and check for Watson on the list in the Install/Uninstall  tab.  If it isn’t there, insert the CoPilot Installation CD and choose the Install Speech option to install the Watson software.

The voice commands that CoPilot recognizes and the response you’ll get from each command are listed below.  Note that when Speak feedback out loud is turned off, you won’t hear answers to questions such as “Where am I?”, but your voice commands will create changes to the map.  And if Speak feedback out loud is on but Listen for voice commands is turned off, you’ll get prompts for upcoming turns although your voice commands won’t be recognized. NOTE:  CoPilot’s voice response is sometimes delayed because it is “thinking” (e.g. when processing a new route or considering future turns) -- be patient!

COMMAND
CoPilot’s RESPONSE

Where am I
Tells you the street you’re currently traveling on, and centers the map around your current position.

Next turn
Tells you where you’ll turn next, and frames your route on the map up to the next turn.

After that
Tells you the next turn after the upcoming turn.

How far
Tells you how many miles left until you reach your destination.

Pick stops
(Not a voice command) When on, you may enter stops in the Trip Planner window by clicking on them on the map.

Zoom in
Your map view zooms in closer.

Zoom out
Your map view zooms out.

Itinerary
(Not a voice command) Opens a window that enables you to avoid any upcoming road segments on CoPilot’s route to your destination.

Detour
(Not a voice command) CoPilot will give you directions to detour around the next five or so miles of your route.  Great for traffic jams!

Resnap
Due to occasional GPS inaccuracy, CoPilot may have you positioned on an incorrect road.  This command resets your current position. 

More detail
Increases the amount of detail shown on the map.

Less detail
Decreases the amount of detail shown on the map.

Clear track
Clears GPS tracking up to your current position on the map.

Heading
Tells you the direction you’re headed.

Speed
Tells you your road speed in miles per hour.

Wake up
Activates voice control.

Go to sleep
Deactivates voice control. TIP:  Use the Sleep command in areas where there’s lots of noise interference, or when listening to the radio!

Speaking 
(Not a voice command) When on, CoPilot speaks out loud to you.

Listening
(Not a voice command) When on, CoPilot recognizes spoken commands.

Logging
(Not a voice command) When on, CoPilot automatically logs your trip as it is tracked.

Menus
(Not a voice command) When on, CoPilot’s menus display as you track.

Thank you
You’re welcome!

WARNING: The GPS control panel, map window, and all other dialog boxes should not be used by the driver if the vehicle is in motion.  Pull over to the side of the road or have a passenger operate CoPilot.  Drive safely.  Obey local traffic laws.  Be alert!

CoPilot 2000’s “Dynamic Directions”

CoPilot provides much more than just the simple GPS tracking done by other GPS software programs: its navigation mode gives turn-by-turn directions to your destination.  In addition, when CoPilot generates a route and directions, they aren’t set in stone.  If your path strays from the planned route, CoPilot automatically incorporates the change and updates your directions while you drive.   This is what we refer to as “dynamic directions”.  Now, if you face unexpected obstacles such as traffic jams, road construction, or accidents which may alter your route, there’s no need to worry.  CoPilot will still get you where you need to go!

When you’re tracking with a destination, CoPilot not only prompts you with the appropriate directions before each turn, but also warns you if you go off route.  When you divert from CoPilot’s original path, the program automatically tells you that you made a mistake, announces that it is recomputing the route, and gives you directions from your new location to your destination.

For example, on the map below, the driver has seen a traffic jam up ahead on U.S. Route 13.  He has decided to turn off CoPilot’s planned route, onto U.S. Route 1:

[PICTURE HERE]

CoPilot notices that the driver has moved off the planned route, tells the driver that it’s figuring out new directions, and calculates a new route to the destination, Holmesburg, PA:

[PICTURE HERE]

A Sample Trip: Navigating

Suppose you and a friend want to drive to Bainbridge House, home of the Historical Society of Princeton, New Jersey.  You know the address of your destination, but you're unfamiliar with the area.  There's no need to worry about the trip:  CoPilot will guide you every step of the way!

First, you enter your destination in the Trip Planner window.  There’s no need to enter a start place (if your GPS receiver is picking up signals, CoPilot already knows where you’re starting from). In the City, State or Zip Code box, you type "princeton, nj" and press <Enter>.  In the Address box that pops up, you type "158 Nassau Street" and press <Enter>.

Now you’re ready to drive to your destination!  Your friend drives the car while you run CoPilot.  (If the GPS panel isn’t showing, open Preferences in the Edit menu and click on the box next to Show text and commands in map window.)  If CoPilot doesn’t automatically start logging when you begin tracking your route (see page 15), select Start Logging from the GPS menu.  (If you start logging, you’ll need to enter a file name in the dialog that opens, e.g. “princetn.gps”, then close the dialog box.)  

Once the car is moving, your location shows up as a series of arrows drawn on the map.  A green-highlighted line from your present location to your destination shows the route for you to follow.  In addition, CoPilot prompts you before each turn (remember to give CoPilot the “Wake Up” command to activate voice technology).

[PICTURE HERE]

CoPilot leads you into Princeton without a problem.  However, as you drive along Witherspoon Street, you notice an accident up ahead.  You decide to turn onto Valley Road in order to save some time.  CoPilot will tell you that you are no longer on the correct route.

[PICTURE HERE]
No Problem!  Within seconds, CoPilot automatically gives you new directions to follow from your new position (see below).  You still get to 158 Nassau Street on time and enjoy a hassle-free trip!

[PICTURE HERE]

CoPilot 2000’s Trip Planning Mode

For printing maps and directions before you get on the road

Entering a Start and End Place

After double-clicking on the CoPilot icon, you’ll be placed in the Trip Planner window with your cursor in the City, State or Zip Code box.  To enter a trip, begin by typing the name of the place where your trip will start or type a ZIP code if you know it, then press <Enter>.  Place names require a comma before the state or province abbreviation (e.g. princeton, nj).  Do not include periods in the abbreviation.  A list of matches to your entry in the database will appear under Your search found, with your entry highlighted at the top.  Green highlighting on the list indicates that CoPilot has validated your entry.  Press <Enter> again to place the highlighted location on the Trip Itinerary list as the start place (“origin”) of your trip.

Enter your destination in the same way as the start place.  The last stop entered on the Trip Itinerary is always the trip destination.  NOTE: For Navigation mode, you only need to enter a destination.

[PICTURE HERE]

Choices for a location may include cities, towns, ZIP codes and various points of interest such as schools, airports, or hospitals.  To enter a point of interest (e.g. empire state building), use the Point of Interest box.  For quicker results, enter a city name and/or state abbreviation  in the City, State or Zip Code box first.

After your start place has been validated, you can create a quick map of the location before running the entire trip by clicking on the Zoom To button to the left of the Trip Itinerary.  This will open the map window and zoom to the location you entered for a closer view.  

To return to the Trip Planner window, click on the Edit Trip button on the tool bar.

Entering Street Addresses

When you enter a place name or ZIP code, the Address box will pop up.  Address entry is optional, not required.  To enter a street-level address for the place you entered, type it in the  Address box, then press <Enter>.  A list of matches in the database will appear under Your search found.  Green highlighting on the list of addresses indicates a valid entry.  If green highlighting appears, make a selection from the list and press <Enter> again.

Entering Stops and Finding Points of Interest

If you are planning a trip with intermediate stops between the start and end place, enter the start place, then your stops in the order you will be visiting them, and then your final destination.  When you run the trip, CoPilot will route you through the stops you entered in the order they appear on the Trip Itinerary, starting at the top.  If you need to move a place to a different position on the list, use the up and down arrow buttons to the left of the list.  To delete a stop, click the Delete Stops button.

CoPilot gives you the option to route through locations that won’t show up as stops on the summary report or your driving directions.  (We call these “via” stops.)  See the on-line Help topic Entering Additional Stops.

To search for points of interest such as schools, stadiums, golf courses, airports, and much more, use the Find Places tab (see the on-line Help topic Finding Points of Interest). 

NOTE: If you chose the compact installation when you installed CoPilot, you may wish to search for additional place types that are not included in your current database.  If so, see the on-line Help topic Adding More Types of Places to Your Database.

Run the Trip!

Click on the Run button to calculate your trip.  The program automatically calculates the distance and time for each trip segment, summarizes your driving directions in an easy-to-read report, and generates a series of maps highlighting your route of travel.  TIP: To return to the Trip Planner window, select Edit Trip from the Trip menu or click on the Edit Trip button on the tool bar.

Printing Your Map or Driving Directions

To print the map or driving directions, click on the tool bar Print icon or use the Print command in the File menu when the map window or the Driving Directions window is active.  Click on either window to activate it.  The active window will be printed.  If either of these windows is minimized, double-click on its icon at the bottom of the screen to activate it

[PICTURE HERE]

Changing Your Route Type and Road Speeds

To change your routing type, click on the Edit Trip button on the tool bar, then click on the Routing Type tab in the Trip Planner window.  Select Quickest (takes the least amount of time) or Shortest (travels the least distance). You can also slide the moveable bars to favor or avoid particular road types.  To return to CoPilot’s defaults for these settings, click on Default.  To turn the preferences you set into new default settings, click on Set Defaults.  

CoPilot will allow you to customize travel times to reflect your own driving preferences.  If, for example, you plan to average 65 m.p.h. on toll roads, you can alter that setting from the 55 m.p.h. default for a more accurate time estimate.  In the Speeds + Distance tab, enter your average road speeds by typing or using the up and down arrows for each setting.  You can also change from miles to kilometers or vice versa.

Helpful Hints - Trip Planning Mode

ENTERING LOCATION NAMES THAT INCLUDE ABBREVIATIONS: Usually you will need to spell out words like "Saint", "Mount", "Fort", etc.  Place names generally need to be spelled out; for example, “John F. Kennedy International Airport” instead of “JFK Airport”.  Try alternate spellings if your entry isn’t accepted the first time, or pick your place from the list under Your search found.

ENTERING INTERSECTIONS AS PLACES:  To enter an intersection of two streets as a start or end place or a stop, type the names of the streets separated by a space and an ampersand; e.g. Washington & Nassau or washington rd & nassau st.

ENTERING ROUND TRIPS:  To run a round trip automatically, click on the Round Trip check box in the lower right corner of the Address tab in the Trip Planner window before running your route.  To turn off the round trip option, click on the check box again.  The round trip will include all intermediate stops on the way to your destination but go directly from your destination back to the start place.

ROUTING THROUGH SELECTED PLACES:  CoPilot gives you the option to route through locations that don't show up as stops on your driving directions.  We call these "via stops".  To the right of each stop on the Trip Itinerary you’ll notice the word “Report”.  To change a reported stop to a via stop, highlight it and then press the <space bar> on your keyboard.  To change it back to a reported stop, press the <space bar> again.  NOTE:  When you navigate, CoPilot’s directions guide you to the intermediate stops you enter in the order you enter them, as if each one were a separate destination.  However, if you enter a stop as a “via”, CoPilot will only direct you to within several miles of the via location before it begins giving you directions to the next stop or your final destination.

MAKING A LIST OF “FAVORITE PLACES”:  CoPilot lets you create a “Favorite Places” list of up to 100 places, with or without street addresses, for faster trip entry.  To add a place to the list, first enter it in the Trip Planner window, then highlight it on the Trip Itinerary and click on the Favorites button.  This will open the Favorite Places dialog box.  Click on Add to add this new place.  The next time you want to enter this place as a start or end place or an intermediate stop, open the Favorite Places dialog and double-click on the place name.  When the number of places on the list reaches 100, each new place you add will eliminate a place from the bottom of the list.

ADDING CUSTOM PLACES:  CoPilot gives you the ability to add your own custom names to the map database.  A custom place name can be entered as a start place, end place, or intermediate stop (see page 29).

Beyond the Basics

If you’ve become familiar with CoPilot’s basic features, you’re probably ready to try CoPilot’s advanced features.  The following pages will show you how to customize your map, edit the database, personalize the directions, and much more.

Picking Stops from the Map

To pick a stop from the map with the mouse, first zoom into the area from which you want to select locations (either places or road/street segments).  Then open the Map menu and select Pick Stops from the sub-menu of Mouse Modes or click on the Pick Stops button on the tool bar.  In the map window click with the left mouse button on the location you want to add to your trip.  It can be a city, point of interest, or any location, including a local address.  TIP: You need to be zoomed in quite closely (level 7 or higher) to pick a stop.  If the Pick Stops button is grayed out, try zooming in for a closer view of the map.  Keep zooming in until the button becomes active (try using the voice commands “Zoom in” and “Zoom out” -- see page 19).  When you pick a stop, the Add to Trip Planner dialog box will appear:

[PICTURE HERE]

Select one of three options to add your location.  You may add the location as 1) the start place, 2) a stop, or 3) the end place.  (Note that any previously-entered start or end place will be eliminated from the trip if a new start or end place is chosen.)  Now click on OK to close the dialog box, then click on the Edit Trip button on the tool bar to bring the Trip Planner window forward.  You'll see that the place you picked is included in your trip.  You can pick multiple stops from the map before running the trip if you wish.

Customizing Your Driving Directions

[PICTURE HERE]

CoPilot gives you precise, turn-by-turn driving directions, plus time and distance calculations for every trip you run between a start place and a destination. (TIP: Try double-clicking on any line in the driving directions -- you’ll zoom to that location on the map!)  Print these directions (see page 22), and/or customize them by editing the font CoPilot uses and by controlling the number and types of “nearby places” -- that is, landmarks or places of interest in the area surrounding your route -- that appear in the report.

To change the appearance of your driving directions, choose Change Fonts from the sub-menu of Itinerary Fonts in the Edit Menu.  This opens a standard Windows dialog box that allows you to change the size and style of the font in the driving directions as you would in any Microsoft Word document.

To control the number and type of landmarks reported, select Landmark Reporting... from the Trip Menu to open the Landmark Reporting dialog box.

NOTE: You can use these options in Trip Planning mode but not in In-Car Navigation mode.

[PICTURE HERE]

Use the slider bar under Find landmarks within this distance of your route to control the size of the area around your route in which landmarks should be reported (e.g. within 1/4 mile on either side of a route).  If you simply want to exclude all landmarks from your driving directions to avoid clutter, move the slider to Off and click OK to close the dialog box.  You can also have landmarks reported only along certain types of roads.  Under Find landmarks when driving on these kinds of roads, use the check boxes to include or exclude the listed road types.

To increase or decrease the number of landmarks reported, use the slider bar under Report this quantity of landmarks in the driving directions.   TIP: The more places you want reported, the more time it will take to generate the driving directions and map for your route.

Use the check boxes in the Find landmarks of type scroll list to choose the types of landmarks you want reported.  This list organizes the types of places CoPilot can identify into broad categories with several levels of sub-categories under them.  Click on the plus sign next to a category at any level on the list to see more.  Click on any minus sign to revert to the next level.

Click on OK to save your changes and close the dialog box.  Click on Cancel to close the dialog box without saving your changes.  Use the Default button to return to CoPilot’s default levels.

Route Optimization

CoPilot can reorder your intermediate stops in the most efficient manner based on the route type you selected for your trip (Quickest or Shortest).  To turn on this option, click on the Optimize Stops button in the lower right corner of the Address tab.  To turn this option off, click on the button again.  Note that when you resequence a route, the start and end places stay the same.

The maps below demonstrate the difference route optimization can make even at the local level.  A start place and end place were entered, along with four intermediate stops within a radius of about 15 miles:

[PICTURE HERE]

The optimized route shown below saved the driver approximately 7.5 miles and 24 minutes driving time!

[PICTURE HERE]

Suppose, as a sales representative, you’re new to a town.  Which potential customers do you schedule your appointments with first and last to optimize your time and sales efforts?  Route optimization will enable you to take the most efficient route and arrive calm and on time for your meetings.

Business professionals, delivery services, home health care workers, real estate agents, homemakers, florists, and others can save time and energy by using route optimization.

Adding a New Place (Custom Places)

CoPilot gives you the ability to add new places with your own custom names to the map database.  After adding your custom place, you’ll be able to enter it as a start place, end place, or intermediate stop for any trip you run.

To add a new place, click on the Add Custom Places button on the tool bar or select Add Custom Places from the sub-menu of Mouse Modes in the Map menu.  The map window should be open and active, and be at a zoom level of 10 or higher (look at the title bar, e.g. “Detail Level 10 or 12”).

Now click on the spot on the map where you want your new place to be added.  A custom place pushpin will appear on the map, and the Custom Place Properties dialog box will pop up.  Type your custom name for the place in the Name box.  The name you enter must be 50 characters or less, including spaces, and must start with a letter (not a number or symbol).  The Longitude, Latitude, and State boxes show the exact location of the new place.  To view the new place on the map at zoom level 12, click on the zoom button to the right of the Longitude box.

[PICTURE HERE]

Managing Custom Places

To edit the name or other information attached to a custom place pushpin once it has been created, either double-click on the pushpin on the map or select Custom Places...from the Data Import menu.  The Custom Places dialog box will pop up showing a list of all custom places in the database.  Highlight the name on the Custom Places list in the dialog box and click on Edit.  The Custom Place Properties dialog box will open.  Make your changes and click OK.

To delete a custom place from the database, highlight it in the Custom Places dialog box and click on Delete.

Entering a Custom Place in the Trip Planner Window

To enter a custom place as a start place, end place, or stop, simply type it in the Trip Planner window as you would any other place in the Place Name field.

Installing the Data To Your Hard Drive

If your PC does not have an easily accessible CD-ROM drive or if you would like to speed up CoPilot’s processing time, you may install the data from CoPilot’s Data CD on your hard drive.  Before you do this, be sure you have enough space.  You will be downloading about 650 MB of data!  Also, NEVER INSTALL THE DATA UNLESS YOU HAVE INSTALLED COPILOT FIRST.  CoPilot may not know where to look for the data unless it was installed before you downloaded the data.

To install the data, first insert the Data CD (disk 2 of 2) into your CD-ROM drive.  Use Windows Explorer to open the folder called “Install” on the Data CD.  Double-click on the setup.exe in that folder, then follow the installation instructions.

Importing Data

[PICTURE HERE]

CoPilot’s Import Wizard gives you the ability to create new sets of pushpins from external data sources.  For example, you might want to import a set of addresses from a contact manager or other source.  CoPilot’s data importing feature combines its ability to locate addresses on the map with its pushpin functionality in a process called “geocoding”.  Geocoding translates addresses and descriptive location information to an exact geographical location (a latitude/longitude point).  The end result of using the Import Wizard will be a new set of pushpins to use for trip planning and map display!

To import a set of places, first select Data Import Wizard from the Data Import menu.  The first Wizard screen (shown above) asks you to identify the source of the data that will be imported.  This can be a data file (Excel or plain text) or ACT!4.0, Microsoft Outlook, or Microsoft Access.  Click on your choice to select it, then click on Next to continue.  Based upon your selection, the Wizard will guide you through the process of entering the additional information needed to import your data set.

To Import a Text File:

1. After opening the Data Import Wizard, select Import pushpins from existing file and click Next; then choose the file name to be imported 

2. Choose a column delimiter used in your import file.  Either select from the provided list (Tab, Comma, or Semicolon) or enter your own in the Other box.  Preview results of your selection in the list box, and scroll down to check that your data is shown in the correct columns below.

3. Click on each column header and select an identifier for that column from the menu that pops up.  Headers that must be included to import a text file are: Name, Address1, City, State, and ZipCode.  You may also choose a pre-formatted set of columns from the Column Order list (click on the arrow to see the list). 

4. If you change any of the column headers, the next screen will give you the option to save the new set of columns you created as a custom file format that will appear in the Column Order list in the future.  To do this, click on the checkbox and enter a name for the new set under Column Description. 

5. Now choose an output file name for the new set of pushpins you will create.

6. Click on Finish to geocode.  When processing is finished, the new set of pushpins will be added to your list of sets in the Custom Places dialog (select Custom Places... from the Data Import menu.

To Import a Microsoft Excel File:

1. Follow step 1 above.

2. If your Excel file contains more than one sheet, select the sheet containing the data you want to import from the drop-down menu.  If the first row contains column headings, make sure to place a checkmark in the Column Headings in first row box.  Click Next when you are satisfied.

3. Scroll through the columns and use the drop-down menu in the second row to select the type of information to be included in the geocoded pushpin.  Keep in mind the following fields are required for the import process: name, address, city, state, and ZIP code.  When you are satisfied, click the Next button.

4. Select an output file name and location for the finished set of geocoded contacts.  Click Finish to geocode.  When processing is finished, the new set of pushpins will be added to your list in the Custom Places dialog (select Custom Places...from the Data Import menu).  

Importing from Microsoft Access, Microsoft Outlook, or ACT!4.0

See the on-line Help topic Importing Data, which includes links to instructions for importing data from these three applications.

The Map Window
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The map window can be moved, resized, and scrolled like other windows in CoPilot (see Working With Windows in CoPilot’s on-line Help if you're unfamiliar with these terms).  The map itself can be viewed from different perspectives, zoomed, drawn with more or less detail, and customized to show, hide and label features such as cities, roads, and places of interest.

Notice that when you move your cursor inside the map window, its shape changes to a cross.  This indicates that you’re automatically in zoom mode and can zoom into any area for a closer view.  To do this, hold down the left mouse button and drag the mouse to make a box around the area you want to see.  When you let go, a new zoomed view of the map will appear.  You can do this several times, until you reach the maximum level of magnification.  Also try zooming by clicking on the Zoom In and Zoom Out buttons on the tool bar (or try speaking the commands “Zoom in” and “Zoom out” -- see page 16).  Or use Zoom Region in the Map menu to frame a particular region (the United States, for example) or Pan Direction to shift your view.

There are twelve possible levels of magnification at which the map can be viewed.  The level of detail shown on the map increases as you zoom in.  The title bar of the map window displays the current zoom level.  The current level of detail is shown in parentheses.  NOTE:  When in Navigation mode, the map will automatically scroll to reposition your location so you’ll always be able to see where you are unless you have this setting turned off in the Preferences dialog box.

At the bottom of the map window you'll see at least three tabs after you run a trip.  The Atlas tab frames your route.  Click on the Start or End address tabs to zoom in for a detailed street map of the start or end place of your trip.  If you entered intermediate stops, there will be a tab for each one.  If there are multiple stops in your trip, all the tabs may not be visible.  In this case, a right and a left arrow will appear in the bottom right corner of the map window.  Click on these arrows to view additional tabs.

Showing and Hiding Map Features
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CoPilot lets you choose from a wide range of features to show or hide on each generated map.  Select Map Features from the Window menu, or click on the Map Features button on the tool bar to bring up the Features dialog box.  Use the Features dialog box while the map window is either open or closed.

Features in the dialog box are listed in levels, beginning with “Map”.  Click on a plus sign to open more levels; click on a minus sign to close a level.  Click on the check box next to a feature to place or remove a checkmark.  All checked features will be shown except when the feature on the next higher level is turned off.  For example, “Streets” has two features, “Street Labels” and “Street Restrictions”, listed under it.  If “Street Labels” and “Street Restrictions” are checked but “Streets” is not checked, street labels and street restrictions won't show up on the map.

To  change the level of detail on the map without changing your zoom level, use the More Detail and Less Detail buttons on the tool bar or the equivalent menu items.  To hide the Road Legend or the Scale of Miles, use the sub-menu of Legends in the Map menu.

To label cities and places on your map, go to the sub-menu of Mouse Modes in the Map menu and select Label Cities and Places.  See Customizing Your Map in on-line Help for more information.

To add notes to your map, select New Note from the Map menu.  The note you type in the window that opens will appear on your printed map.

Adding and Removing Street Restrictions
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You can alter how road segments appear on the map by changing a two-way street to one-way and vice versa, and by marking a segment to be avoided.  Note that your edits will become permanent in the database unless and until you go back at some point and re-edit.  Any change you make will potentially affect how your trips are routed until you reverse the change.  Note also that you can change streets but not highways.

To make these changes, you must have the map window active and be at a zoom level of 7 or higher (the title bar of the map window shows the current zoom level).  With your cursor in the map window, press the right mouse button and select Edit Street Restrictions from the sub-menu of Mouse Modes, or click on the Edit Street Restrictions button on the tool bar.   Now point to a road segment with the cursor and press the right mouse button.  The segment to be altered will be highlighted and you’ll be able to select an option from the right mouse menu.  See Adding and Removing Street Restrictions in on-line Help for more information.

Accessing the Internet With the Geo*Browser™

If you have an Internet connection and Web browser software installed on your computer, you can access the Internet from within CoPilot.  Select Our Web Site... from the Help menu to go to Travroute’s home page, or use TravRoute’s unique Geo*Browser to access travel information about a particular city or town.  TravRoute’s Web site gives you access to a wealth of information including listings of hotels and restaurants, business services, car rental agencies, and tourist attractions in or around a specific area, plus construction and weather reports and more. See the on-line Help topics Accessing Our Web Site From CoPilot and Using the Geo*Browser.

Trouble-shooting

First things to check: Are all cables properly secured?  (CoPilot won’t receive GPS signals if they’re not.)  Do all components have adequate power?  Does your GPS receiver have a clear view of the sky?  (Buildings, mountains and heavy foliage may block your satellite reception.)

Why can’t I get a satellite reading the first time I use CoPilot?

The first time the GPS receiver is used it takes approximately 5 minutes to acquire a signal (but may take as long as 15 minutes).  Once initialized, the unit should acquire satellite signals in 1 minute or less in future uses.

Why does it take so long to find the satellites?

When the GPS unit is first initialized it can take several minutes for the receiver to locate the satellites in orbit.  Be sure that the GPS receiver has an unobstructed view of the sky.  Trees, buildings and other obstacles are capable of blocking the satellite signals.  

I have CoPilot hooked up properly and have waited several minutes for a GPS signal but still do not see anything on the map.  What should I do?

The software has been set by default to filter out GPS readings while the car is stationary.  Try driving to verify that CoPilot will track you.  If you are the driver, verify this using the voice control features -- do not watch to see if you get a signal on the screen while driving!

What should I do if the message “insert data disk” or “cannot read data disk” appears when disk #2 (the data CD) is in the CD-ROM drive?

Take the disk out and clean it…then place it back in the drive and allow time for the disk to spin up to speed.  If that does not solve the problem, then abort CoPilot and try to read the Door10 file on your CD-ROM drive from Windows Explorer.  Then restart the program.

What should I do if I get an error message that reads “mfcans32.dll is missing”?

This usually occurs with Windows NT and you may download the file from the “Support” page at http://www.travroute.com.

What should I do if I have a fatal exception (e.g. “OE 0137:BFF9A07C”) when printing maps?

From Windows 95 Start, go to Settings \ Control Panel \ Display \ Settings to check your color palette (even if you have a black and white printer).  Changing the settings to 256 will correct your problem.

What do I do if the computer will not recognize my voice commands?

Go to the Edit menu on the tool bar.  Select Preferences and then select Speech.  Make sure the boxes next to Listen for voice commands and Speak feedback out loud are both checked.  For best results, an external microphone is recommended.

I copied the large place database from the install CD to my hard drive and now CoPilot crashes each time I try to use it.  What can I do?

Make sure that you have unchecked “READ ONLY” under the Properties menu of the poi.mdb file.  To do this, find poi.mdb on your hard drive (the default location is C:\Program Files\TravRoute\CP2000\Places), then right click on poi.mdb, select Properties, and make sure that “READ-ONLY” is NOT checked.

Using On-line Help

CoPilot provides extensive on-line help to guide you through the program as you use it.  Press the F1 key on your keyboard for help with the specific feature your cursor is currently pointing to.  Or click on the Help button in a window to open a Help topic that describes how to use that window.  For example, if you’re adding stops in the Trip Planner window, the Help button will open on-line help at the topic Entering Additional Stops.  From there, you can navigate through other Help topics, or do a search on a topic using the Search dialog box.

Another way to access on-line help is through the Help menu.  Contents will open Help at the Table of Contents, which displays the main topics available.  Topic Search opens the Search dialog box.  How to Use Help provides Microsoft instructions about using on-line help.

You also have the option of activating “bubble help” which automatically provides brief hints as you pass the cursor over certain areas.  In the Edit menu, select Preferences and check Show hints in the Preferences dialog box.

